Introduction to Seagate Analysis
The Report and Query Tabs in Seagate Analysis

Overview
This document aims to provide an introduction to Crystal Decisions’ new
business analysis tool, Seagate Analysis.
Definition of terms, architecture, usage and features are discussed. This
document should be consulted in addition to the Seagate Analysis On-line Help.
Further information on specific topics can also be found in the Seagate Crystal
Reports Version 7 User’s Guide and the Seagate Info Version 7 User’s Guide
Seagate Analysis embodies many features of the Seagate Crystal Reports
Designer, Seagate Crystal Query Tool, the Seagate Info Cube Designer and the
Seagate Worksheet. This document focuses primarily on the Query and Report
tabs of Seagate Analysis.
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Introduction
Seagate Analysis is a powerful, easy-to-use, desktop tool for analysis of
business information.
Seagate Analysis combines the ability to perform ad-hoc database queries and
navigate multi-dimensional cubes of data (OLAP). It helps the business user
make sense of just about any data source imaginable - from a simple report on
disk space allocation to complex web traffic analysis. Seagate Analysis also has
integrated report viewing to ensure that information can be presented in a crisp,
meaningful way.
Seagate Analysis integrates three existing components:
•

The proven report viewing capabilities of Seagate Crystal Reports, the
world standard for desktop reporting and analysis,

•

Seagate Query, a tool for ad-hoc database queries,

•

The proven functionality of Seagate Worksheet, a best-of-breed tool for
multi-dimensional data navigation.

Seagate Analysis also delivers full integration with Microsoft Excel, to enable
the user to easily drop data into Excel's familiar analytical environment.
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Minimum System Requirements
•

Windows 95, Windows 98 or Windows NT 4

•

Pentium 90 (Pentium 133 recommended)

•

32 MB of RAM (64 MB recommended)

•

CD-ROM drive

•

30 MB free disk space for the install

•

100+ MB recommended for temporary working area.

•

Microsoft Internet Explorer 4 or Netscape Navigator 4

NOTE

Cube building with large data sets may require more disk space.

Opening a sample Seagate Analysis document
Seagate Analysis comes complete with many sample Analysis documents that
illustrate the power of this analytical tool, such as the Web traffic reports and the
Back Office reports.

To open a sample Analysis document
From the Windows Explorer:

•

Right-click an .rpt file and choose Open with Seagate Analysis
from the shortcut menu.

If Seagate Crystal Reports is not installed on your computer, double-clicking an
.rpt file automatically starts Seagate Analysis.
From the Windows Desktop:

1. Start Seagate Analysis.
2. In the Welcome to Seagate Analysis dialog box, select Open
an Analysis document from your Favorites list, then
click OK.
3. In the Open dialog box, choose the document and click Open.
NOTE
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When you open a report or an Analysis document, Seagate Analysis creates a
temporary backup of the file in the same directory as the .rpt file. This file stores
the changes that you make until you save the Analysis document.
Seagate Analysis saves the Query, and, if you have already created them, the
Report and Cube definition to an .rpt file. When you open a file that contains a
formatted report, Seagate Analysis opens in Report view. When you open a
sample document that contains a cube definition but no formatted report,
Seagate Analysis opens in Cube view. Otherwise, it opens in Query view.
•

To open a different sample document, choose a document from the
Favorites menu.

•

To open an existing Analysis document or a Crystal report, choose the
Open command from the File menu, or click the Open button on the
toolbar.

•

To create an Analysis document from Seagate Analysis, choose the New
command from the File menu, or click the New button on the toolbar.

To open a recently used Analysis document
You can choose it from the File menu, which contains a list of the five most
recently opened documents, or:
1. Open the Help menu, and choose Welcome to Seagate Analysis.
2. In the Welcome to Seagate Analysis dialog box, click Open an Analysis
document from your History list.
3. In the Open dialog box, choose the document you want and click Open.
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Opening an existing document
Seagate Analysis allows you to open any document created in Seagate Crystal
Reports and view the query that was used to produce it. You can create a Crystal
report in Seagate Crystal Reports and in Seagate Info.

To open a Crystal report or Analysis document
From the Windows Explorer:

•

Right-click an .rpt file and choose Open with Seagate Analysis
from the shortcut menu.
If you do not have Seagate Crystal Reports installed, double-clicking an .rpt
file starts Seagate Analysis.

From the Windows Desktop:

1. Start Seagate Analysis.
2. In the Welcome to Seagate Analysis dialog box, select Open an
existing Analysis document
3. Click OK.
4. In the Open dialog box, choose a document and click Open.
When you open a Crystal report or an Analysis document, Seagate Analysis
creates a temporary backup of the file in the same directory as the ..rpt file. This
file stores the changes that you make until you save the Analysis document.
Seagate Analysis saves the query, and if you have already created them, the
report and cube definition to an .rpt file. If you open an .rpt file that contains a
cube definition, Seagate Analysis opens in Cube view. If you open a file that
contains a formatted report, Seagate Analysis opens in Report view. Otherwise,
it opens in Query view.
•

To open one of the samples, choose a file from the Samples subdirectory.

•

To open a different document from Seagate Analysis, choose the Open
command from the File menu, or click the Open button on the toolbar.

•

To open a sample document from Seagate Analysis, choose a document
from the Favorites menu.

•

To create a new document in Seagate Analysis, choose File | New, or
click the New button on the toolbar.

To open a recently used Analysis document:
Either choose it from the list of the five most recently opened documents on the
File menu, or:
1. From the Help menu, choose Welcome to Seagate Analysis.
2. In the Welcome to Seagate Analysis dialog box, click Open an
Analysis document from your History list.
3. In the dialog box, choose a document and click Open.
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The Analysis Explorer
The Analysis Explorer shows you all the fields that you have added to
the query, as well as all the data sources to which you can connect. A data
source can be an ODBC data source, a SQL data source, an existing document,
or one of your favorites. The Analysis Explorer lists all the tables and fields that
you can use as part of the query. You use the Analysis Explorer to add tables
and fields to the query. You can also create new fields, such as formulas, SQL
Expressions and parameters.

The Analysis Explorer can be invoked in three ways:

•

by default when you create a new Analysis document.

•

when you choose Data|Data Sources in Query view

•

when you choose View|Query Content.

The Analysis Explorer consists of two tabs:

•

the Data Sources tab, and

•

the Query Contents tab.

Data Sources tab
The Data Sources tab of the Analysis Explorer displays all the available
data sources and their corresponding tables and views.
Seagate Analysis currently supports ODBC data sources. If you run Seagate
Analysis from with Seagate Info, you can also use the database connections in
Info Desktop objects as data sources. If you run Seagate Analysis as a standalone application, you can use the database connections in the supplied samples
as data sources.
Click the (+) to expand the Data Sources directory tree. You’ll see that the tree
is divided into a subset of the following subdirectories:[SS1]sections
•

Data Sources

•

File Directory (if you run Seagate Analysis as a stand-alone application)

•

Seagate Info (if you run Seagate Analysis from within Seagate Info)

•

My Favorites, if any exist.

The Data Sources folder contains all of the data sources available to the
user.
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This folder contains the following subdirectories:
•

Microsoft Exchange Admin

•

NT Event Log

•

ODBC

•

OLE DB

A list of other available data sources is also provided. This list allows you
create reports off your system. For example, clicking on Microsoft Outlook will
allow you to report off your email folders.
If you run Seagate Analysis as a stand-alone application, you can use the
database connections in the sample reports as data sources for new reports. The
File Directory folder contains these connections.
If you run Seagate Analysis from within Seagate Info, you can use the database
connections in Info Desktop objects as data sources for new reports. The
Seagate Info folder tree contains all the database connections on the Info
APS. To use an existing report as a database connection, on the Info Desktop
set the property Serve as database connection for the report. See the
Seagate Info documentation for details.
The My Favorites subdirectory will only become accessible through the
Analysis Explorer window once you have added your own data sources to this
folder. When SA is first installed, the My Favorites subdirectory can only
be accessed through the menu and contains sample reports that can also be used
as data connections. This means that if you select one of these template files,
you will be re-using the connection information stored with the particular report.
Add data sources and report files you use frequently to the My Favorites
directory.
For more information on the Favorites list, refer to Working with the
favorites list section below and in the On-line Help file.
Once you have selected your data source, right-click a table and choose
Insert Table to add the table to the Tables panel of the Query designer.

Working with the favorites list
The favorites list is used in two places in Seagate Analysis.

6/25/2002 3:58 PM
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Adding a data source to the list of favorite data sources:
1. In the Analysis Explorer window, right-click a database connection name
(this can be an entire database file or a single database table).
2. Choose Add to Favorites to add the database connection to your
favorites list.
3. Choose the folder for this document, or click the New Favorite
folder button on the toolbar to create a new folder. The New
Favorite folder button remains unavailable until you select a folder.
4. Click OK.

Adding a document to the list of favorite documents:
The list of favorite documents is available on the Favorites menu.
If you run Seagate Analysis as a stand-alone application you can add the current
document to your list of favorite documents. You can also add an Analysis
document or Crystal report on the local computer.
If you run Seagate Analysis from within Seagate Info, you can also add a
document from the Info APS.

To add the current document:
1. From the Favorites menu, choose Add to Favorites.
2. Choose the folder for this document, or click the New Favorite
folder button on the toolbar to create a new folder. The New
Favorite folder button remains unavailable until you select a folder.
3. Click OK.

To add a document from the local computer:
1. From the Favorites menu, choose Organize Favorites.
2. Click the Add more Favorites from button on the toolbar.
3. Choose Available Local Documents from the list on the left.
4. Type in the name of the file including the path, or click Browse.
5. When the name of the file is displayed in the File box, drag the blue flag
icon to a folder in the favorites tree on the right.
6. When you have finished adding documents, click OK.

To add a document from the Info APS:
1. From the Favorites menu, choose Organize Favorites.
2. Click the Add more Favorites from button on the toolbar.

6/25/2002 3:58 PM

Copyright  2001 Crystal Decisions, Inc. All Rights Reserved.

Page 10

Introduction to Seagate Analysis

The Report and Query Tabs in Seagate Analysis

3. Choose Available Remote Documents from the list on the left.
4. In the tree on the left, click the name of the Info APS. Expand the tree until
you find the document you want to add.
5. Select the document and drag it to a folder in the favorites tree on the right.
6. When you have finished adding documents, click OK.

Query Contents tab
The Query Contents tab lists the contents of the current query, which
includes:
•

the database fields used in the query,

•

the database tables used in the query,

•

summary fields,

•

formula fields,

•

SQL Expressions, and

•

parameter fields.

Adding Fields to a Query from the Query Contents tab
To add database fields to a specific part of your query:

1. Right-click the field
2. Select Add To on the shortcut menu
3. Specify where you want to add the field by choosing the corresponding
panel in the submenu.
To add Formula fields, SQL Expressions and Parameter fields to the query:

1. Right-click the field
2. Select Insert on the shortcut menu.
3. Choose the type of field to you want to add from the submenu.
4. Specify the details of the field in the Edit Formula Field dialog box,
the Edit SQL Expression Field dialog box, or the Parameter
Field dialog box, as appropriate.
See Adding Formula Fields, Adding SQL Expressions, and Adding Parameters.
To add Summary fields to the query:

1. Right-click on any selected field in the Explorer and choose Create
Summary Field from the shortcut menu.
2. Specify the properties of the field in the Create Summary Field
dialog box.
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When a summary field is created, it is automatically added to the Fields
panel.
To view the contents of a database field in the Query Contents tab:

1. Right-click the field.
2. Choose Browse Field from the shortcut menu.

The Query tab
A query is a request for specific information from a database. Once you have
created a query, you can keep refining it until you retrieve exactly the
information you want. You can view the information in a report, or use it as the
basis of a cube.
If you want to create a cube, you need to design the query to suit the cube you
want to build. In general, you need to retrieve a larger volume of information for
this type of query, and it should be in a more summarized form. See Hints on
Cube Design in the On-line Help file for more details on cube building.
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Creating a simple query
To get the data you want for the query, add the tables that contain the data to the
Tables panel. This panel gives you a clear picture of the sources of data you
are using and relationships between them. You can use it to organize the tables
you are using, as well as to define and maintain the links between them.
Once you have added and linked the tables you want to use for the query, it may
be easier to hide the Tables panel and use the Analysis Explorer to add fields
to the query.
To hide the Tables panel:

•

Click the Show/Hide Tables toolbar button, or

•

Open the View menu, and choose Tables. (Repeat the process if you
wish to redisplay the Tables panel.)

Adding tables
There are three ways to add a table to the Tables panel:

Select the table in the Data Sources tab of the Analysis Explorer and:
•

Double-click the table, or

•

Right-click the table and choose Insert Table from the shortcut menu,
or

•

Drag the table to the Tables panel.

To remove a table from the Tables panel:
•
NOTE

Right-click the table and choose Remove Table from the shortcut menu.
If the database you are accessing is protected by a password, Seagate Analysis prompts
you for a user name and password when you select the corresponding ODBC data source
in the Analysis Explorer.
See Logging on to a database in the Seagate Analysis Online Help file.
If the location of the database changes after you have created a report, use the Set
Database command to change the query so that it accesses the database in the new
location.
See Changing the data source accessed by a report in the Seagate Analysis Online Help
file.
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Browsing tables
If you want to determine the contents of a field or a table, you can browse a
subset of the records.
To browse a table

•

Right-click the table and choose Browse Table from the shortcut menu.
A dialog box appears, displaying records for all the columns in the table.

To browse a field

•

Right-click the field and choose Browse Field from the shortcut menu.
A dialog box appears, displaying records for the selected field in the table.

Setting the browse data size
You can control how many records are returned when you browse a table or
field by going into the Tools menu, and choosing Options. Specifying a
browse records size prevents Seagate Analysis from fetching the whole data set
each time you browse. For example, if you set the browse data size to 100,
Seagate Analysis returns the first 100 records, but removes the duplicate entries.
For more information, see Setting the browse data size in the Seagate Analysis
Online Help file.

Linking tables
When the query takes data from more than one table, it is necessary to link the
tables together. You link tables so records from one table match the related
records from another. For example, if the query uses an Orders table and a
Customers table, you link the tables so that each order (from the Orders table)
can be matched up with the customer (from the Customer table) who placed the
order.
When linking tables, you link on a field that is common to both tables. Seagate
Analysis uses this linking field to match up records from one table with those
from the other.
When creating the link, it is important to link from one table to another table.
The from table is used as a ‘primary’ table, while the to table acts as a ‘lookup’
table where records are looked up by the primary table. In a simple link, Seagate
Analysis examines the first record in the primary table and finds all matching
records in the lookup table. Once all matches have been found in the lookup
table for the first record in the primary table, all matches in the lookup table for
the next record in the primary table are found.
When linking SQL tables, you can specify the type of join you want to use in
Seagate Analysis. An SQL join indicates how linked fields in two SQL tables
are compared when records are read. When you create an SQL link, it is set to
an equal join by default. The result set from an equal join includes all the
records where the linked field value in both tables is an exact match. Specify the
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join type using the Link Properties command, which is described below.
For full details of the different join types, refer to the Seagate Analysis On-Line
Help.
The easiest way to link database tables is to use the Smart Linking
command. Smart Linking automatically chooses links for your tables based on
common fields in tables.

To link tables automatically:
•

Right-click anywhere in the Tables panel and choose Smart Linking
from the shortcut menu. Alternatively, you can choose Smart Linking
from the Data menu.

To link two tables manually:
•

Click the field that you want to link in the from table

•

Drag it to the field in the to table.

The link appears as an arrow between the two fields. Use the Link
Properties command to change the join type.

To set the properties for a link:
1. Right-click the link and choose Link Properties from the shortcut
menu.
2. In the Link Properties dialog box, set the type of link and click OK.

If you are linking tables from the same ODBC data source, choose an
option in the Join Type area. For full details of the different join types,
see the Seagate Analysis On-Line Help.
If you are accessing a non-ODBC data source and linking three tables in an
A to B, A to C manner, you can select a Lookup Type in addition to a
join type. The lookup type determines the order in which Seagate Analysis
looks up the records in the tables B and C. In this case Seagate Analysis
uses a native driver to connect to the database, rather than an ODBC driver.
There are three lookup types available:
•

6/25/2002 3:58 PM

Parallel lookup type This option is also referred to as ‘look up both at

the same time’. For each record in Table A, this option looks for a
matching record in Table B and a matching record in Table C. Then it
looks for the next matching record in Table B and the next matching
record in the Table C, and so on. Once it finds all the matching records,
it repeats the process with the next record in Table A, and so on.
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NOTE

•

Series lookup type This option is also referred to as ‘look up all of
one, then all of others (A to B, A to C)’. For each record in Table A,
this option first looks for all the matching records in Table B and then
looks for all the matching records in Table C. Once it finds all the
matching records, it repeats the process with the next record in Table
A, and so on.

•

Product lookup type This option is also referred to as look up all the
combinations of the two files. For each record in Table A, this option
looks for a matching record in Table B, and then finds all the matching
records in Table C. Once it finds all the matching records in Table C, it
repeats the process with the next record in Table B, and so on. Once it
comes to the end of the matching records in Table B, it repeats the
process with the next record in Table A, and so on.

If you have more than one link between two tables, all the links must be of the same type.

To delete a link:
•

Right-click the link and choose Delete Link from the shortcut menu.

To remove all links between two tables:
•

Right-click one of the links and choose Delete All Links from the
shortcut menu.

Finding tables
If the query contains many tables, you may not be able to see a particular table
in the Tables panel. Use the Locate Table command to scroll quickly to
the selected table in the panel.
To find a specific table:

1. Right-click anywhere in the Tables panel and choose Locate Table
from the shortcut menu.
2. In the Locate Table dialog box, choose the name of the table you want from
the list. The Tables panel scrolls to show the table you have selected.
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The query design panels
Design your query in the Design panels, which is located beneath the Tables
panel. You can add fields to the Design panels from the Analysis Explorer or
from the tables displayed in the Tables panel. Adding and deleting fields is
described in more detail in the following section.
The Design section is structured like a SQL query, with a panel representing
each SQL clause. You can build the query by placing fields in the appropriate
panels.
•

Fields panel supplies the SELECT clause

•

Filters panel supplies the WHERE clause

•

Groups panel supplies the GROUP BY clause

•

Sorts panel supplies the ORDER BY clause

Seagate Analysis, by default:
•

displays the Fields and Filters panels

•

hides the Groups, Sorts, Group Filters and Analysis Fields
panels

You can choose which panels you want to display or hide by going to View |
Design Panels, then selecting or de-selecting the appropriate panels from
the submenu.
You can hide all the design panels by clicking the Design button on the
toolbar. This is useful if you want to concentrate on linking tables, or on the
query results. The Design button toggles between showing or hiding the
Design panels.
The Result Set panel, located beneath the Design panels, displays the
record set that results from running the query.

Adding and deleting fields
There are three ways to insert a field into the query:

6/25/2002 3:58 PM

•

drag the field from the Tables panel to the appropriate panel,

•

drag the field from the Query Contents tab of Analysis Explorer to the
appropriate panel, or

•

right-click the field from the Query Contents tab of Analysis Explorer.
Select Add To in the shortcut menu. From the submenu, choose the panel
to which you want to add the field.

Copyright  2001 Crystal Decisions, Inc. All Rights Reserved.

Page 17

Introduction to Seagate Analysis

The Report and Query Tabs in Seagate Analysis

To delete a field:

•

Right-click the field and choose Delete from the shortcut menu.

The Fields Panel: Selecting the fields to use in
the query
Specify the fields to include in the query by adding them into the Fields
panel. You can add either individual fields or all the fields in a table at once.
The Fields panel supplies the SELECT clause of the SQL query.
To add a field to the Fields panel:

•

Drag a field from a table in the Tables panel to the Fields panel.

To add all the fields in a table to the Fields panel:

•

Right-click a field in the chosen table in the Tables panel and choose Add
All Fields from the shortcut menu.

The Sorts Panel: Sorting the query
By default, the query results appear in the order they are returned from the data
source. However, you may want to specify your own order, for example, to sort
sales transactions according to the amount spent by each customer. You do this
by adding fields to the Sorts panel.
The Sorts panel supplies the ORDER BY clause of the SQL query.
If you sort by more than one field, the sorts are applied in the order in which
they appear in the Sorts panel. You can also sort by fields that are not
included in the query, although they exist in one of your tables.
When sorting on multiple fields, Seagate Analysis first sorts the records based
on the values in the first field selected, putting them in ascending or descending
order as specified. When two or more records have the same field value in the
first sort field, Seagate Analysis then sorts those records based on the value in
the second sort field. For example, in a sort on last name and then first name (in
ascending order), Smith, Bob would be returned before Smith, John no matter
which way the fields are listed in the database. The process is similar for three
field sorts, four field sorts, and so on.
All sorts can be ascending or descending; the default is ascending. The data type
of a field determines the method in which the data from that field is sorted. An
ascending sort means that the numbers 0-9 (in that order) come before A-Z.
To sort the query results by the values of a field:

•

Add the field to the Sorts panel.

To change the sort order:

6/25/2002 3:58 PM

Copyright  2001 Crystal Decisions, Inc. All Rights Reserved.

Page 18

Introduction to Seagate Analysis

The Report and Query Tabs in Seagate Analysis

1. Either double-click the field, or right-click it and choose Edit from the
shortcut menu.
2. In the Edit Sort Order dialog box, choose ascending order or
descending order.
If the field you are sorting by is a summary field, you can also choose to
sort:
•

all of the values,

•

only the top N values, or

•

only the bottom N values.

3. Click OK.
4. Click the Preview button on the toolbar to display the sorted the data.

The Groups Panel: Grouping the query
The Groups panel enables you to group the query results into categories and
supplies the GROUP BY clause of the SQL query. These categories are then
displayed in the result set and in the report. For example, you might need to
show the orders made by each customer in the report. To do this, you must have
the fields Order ID and Customer in the Fields panel and Customer in the
Groups panel. When you group the data, it is easier to navigate the data in both
the result set and in the Report view. You can drill down on the areas of interest
using the group tree.
See Viewing grouped data in the result set in the Seagate Analysis On-Line
Help.
You can group the query results based on database fields, formula fields, or
specify your own grouping. Note that you can use a formula based on a
parameter as a grouping field.
See Adding Formula Fields and Adding Parameters.
Once you have specified a grouping, you can add a group total or a different
summary field to the query. In this way, you can show a group total at the end of
each group in the report, or a grand total at the end of the report. For example,
you could create a summary field that totals up all the orders for each customer.
See Creating Summary Fields below, or in the On-Line Help
If the query uses grouping, you can choose to perform the majority of the
processing on the database server and push only the result to your computer.
See Performing the grouping on the server in the Seagate Analysis On-Line
Help.
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NOTE

If you specify a field to group by, Seagate Analysis needs to sort by that field or a
summary of it. Adding a field to the Groups panel automatically adds the same field to
the Sorts panel. Only delete this sort field from the query if you replace it with a
summary field.

Using custom grouping
Most of the time, data is sorted based on the values from a field in the report.
For example, if you have a customer list and you want to group by state, Seagate
Analysis first sorts the list by state. Then it breaks the list into state groups
whenever the value in the State field changes.
Sometimes, however, you may not want to group based on the values found in
one of the fields on your report.
For example:
•

The report may not contain the field you want to group on. Your report may
contain a City field but not a State field, although you need to group by
State. In this case, you could build for each state, and manually assign the
city values that you want to be in each group.

•

The report may contain the field you want to group on, but you may not be
happy with the grouping based on the values in that field. For example, you
may have a Color field on your report that includes specific color names,
such as Navy Blue, but you want all shades of each color to appear as a
single group, such as Blues. In this case you can build custom groups and
manually assign the records you want to be in each group.

•

The report may contain the field you want to group on, but you only want to
include specific values or ranges of values for each group. For example, you
might want one group to contain records where gross sales are less than a
certain value, a second group where gross sales are greater than a certain
value, and a final group where gross sales fall between two values. In this
case, you can build your groups using the same range of selection facilities
that are available to you for building record selection queries.

Custom grouping enables you to create both the customized groups that will
appear on your report and the records that each group will contain. Your only
real limitation is that a record can be assigned to only one group.
To create custom grouping:

1. Right-click on the grouping field and choose Change to Custom
Grouping from the shortcut menu.
2. In the Edit Specifying Group dialog box, choose a grouping that
you want to change from the list.
3. In the tabbed dialog pane, specify the members of the group.
4. Repeat steps 2 and 3 for all the groupings you want to change.
5. If you want to create a new grouping, click the new tab.
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6. Specify how the remaining records are to be grouped using the Group
Others area.
7. Click OK.

Creating summary fields
If you want to insert a summary of the data, such as an average, sum, or a count
for a group, you can add a Summary Field to the query. For example, you might
need the total number of orders made by each customer. To do this, you must
have the Order ID in the Fields panel and the Customer field in the Groups
panel. To create a summary field that adds together all the orders for each
customer, select the Order ID field in the Fields panel and choose Create
Summary Field from the shortcut menu, choosing 'Count' as the summary
operation.

To create a summary field for one group level:

1. Right-click the selected field in the Fields panel and choose Create
Summary Field from the shortcut menu.
2. In the dialog box, choose the appropriate summary group from the list.
3. Choose the summary operation you want to use. The choices available
depend on whether the field contains numeric, or non-numeric data.
4. Click OK.
To create a summary field on all groups in the report:

•

Right-click the selected field in the Fields panel and choose Create
Summary Field on All Groups from the shortcut menu.

This creates a summary at each group level, and creates a grand total for the
entire report.

To edit a summary field:

•

Double-click the field, or

•

Right-click the field and choose Edit from the shortcut menu.

The Filters Panel: Restricting the data
Often you'll want to restrict the data returned by the query by specifying
selection criteria that a record must satisfy for it to be included in the query's
resulting data set. You do this using the adding the fields on which you want to
put a restriction into the Filters panel.
The Filters panel supplies the WHERE clause of the SQL query.
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To specify a selection condition:
1. Add the field whose value you want to restrict to the Filters panel.
2. Right-click the field and choose Edit from the shortcut menu.
3. In the Edit Field Range dialog box, choose a type of condition from
the list. If a value is required, type it in the list that appears below, or choose
a value from the list. You can also use a parameter as the value.
4. If you want to add any other conditions to the query, add the fields to the
Filters panel and repeat steps 2 and 3. By default, new conditions are
added to the existing ones with an AND operator between them. Doubleclick the AND operator to switch it to an OR operator.
If you add multiple conditions, specify how they are applied by changing
the logical operators between them and the way they are grouped. Refer to
Adding operators to conditions (below) for more details.
5. Click OK.

Modifying selection conditions
To modify a condition in the Filters or Group Filters panel:

1. Double-click the field, or right-click the field and choose Edit from the
shortcut menu.
2. Make your changes in the Edit Field Range dialog box.

Adding operators to conditions
When you add multiple conditions in the Filters and Group Filters
panels, combine them using operators and brackets.
To add operators or brackets to a field:

1. Right-click the field, point to Add Operator in the shortcut menu and
choose from the submenu.
2. The operator appears before the selected field.
3. Double-click an operator to switch it between AND and OR.

The Group Filters panel: Restricting
summarized data
If you have added a summary field on one of your groups and want to restrict
which groups appear in the query results by the values in the summary field, you
need to add the restriction to the Group Filters panel.
The Group Filters panel supplies the HAVING clause of the SQL query.
NOTE
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Filters panel can only contain summary fields.
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To restrict summarized data:
1. If necessary, choose the Group Filters Panel option from the View |
Design Panels shortcut menu to display the Group Filters panel.
2. Add the summary field whose value you want to restrict to the Group
Filters panel.
3. Right-click the field and choose Edit from the shortcut menu.
4. In the Edit Field Range dialog box, choose a type of condition from
the list. If a value is required, type it in the list that appears below.
NOTE

You can also use a parameter to specify the value. See Creating parameter fields and
Creating Complex Queries.

5. If you want to add any other conditions to the query, add the fields to the
Group Filters panel and repeat steps 2 and 3. By default, new
conditions are added to the existing ones with an AND operator between
them. Double-click the AND operator to switch it to an OR operator.
You can specify the order Seagate Analysis applies multiple selection
conditions by changing:
•

the logical operators between them, and

•

the order they appear in the Group Filters panel.

6. Click OK.

The Analysis Fields Panel
Parameters, formulas and SQL expression fields are added to the Analysis
Fields panel in the query. To use one of these fields, drag it from the
Analysis Fields panel to the relevant query design panel. You can also
see a list of these fields in the Query Contents tab of the Analysis Explorer.
To edit a field in the Analysis Fields panel:

NOTE

6/25/2002 3:58 PM

•

Double-click the field, or

•

select the field, right-click it and choose Edit from the shortcut menu.
If you remove a field from the Analysis
the entire query.

Fields panel, the field is removed from
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Copying data to Microsoft Excel
Seagate Analysis makes it easy to move data into Microsoft Excel, so that you
can take advantage of its powerful analytical features.

To copy data to Excel:
1. In the grid view of the result set, drag the mouse to select the cells you want
to copy.
2. To select ranges of cells, hold down the SHIFT key while you click a cell.
To select nonadjacent cells, hold down the CTRL key while you click a cell.
3. Go to Edit | Copy to Excel. This launches Microsoft Excel, and
shows the data you selected. The rows and columns in the result set are
mapped to corresponding rows and columns in Excel.

NOTE

You can only copy data from Analysis to Excel; you cannot copy from Excel into Analysis.

Saving a query
The Save command saves the whole Analysis document, which includes your
query, as well as the report, worksheet, and cube definition if you have already
created them. The document is saved to a .rpt file.

To save the document:

6/25/2002 3:58 PM

•

Click the Save button on the toolbar, or choose File | Save.

•

If you want to save the current data in the report, check the Save with
Data option in the File menu before saving. Otherwise, the report may
display different data the next time you open it.

•

To save the document to a different filename, use the Save As command.
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Creating complex queries
You can create powerful and flexible queries that give exactly the information
you want. Formulas and SQL expressions add calculations to the query.
Parameter fields allow you to create a single query that you can modify
whenever your needs change.

Performing calculations on the data
Calculations allow you to create new fields for the query, based on existing
database fields. For example, you can add a calculation to find the difference
between order and delivery times, using the order date and ship date fields.
There are two types of calculations that can be added to a query:

NOTE

•

Formula, and

•

SQL expression
SQL expression fields are only available when you use an SQL-capable database or an
ODBC data source.

Adding formulas
Formulas use the calculation capabilities of Seagate Analysis, and have a much
wider range of calculations available than SQL expressions.
To display data that is a calculated value, you need to create a formula field and
place that formula in the query. For example, if the database only stores the
order dates and ship dates for orders but you need to display the number of days
it takes to ship the order, you must create a formula that will calculate the
number of days between ordering and shipping. This is just one example of the
use of formulas.
Go to Favorites | Web Server, and choose the sample report ‘Most Popular
Directories (Top 10)– NCSA’ for an example of using formulas.

To add a formula:
1. Go to Insert | Formula. Make sure the ‘Perform on server’ box is
unchecked.
2. Click OK.
3. In the New Name dialog box, type a name for the field in the Name box.
4. In the Edit Formula Field dialog box, you can double-click or drag a
field, function, or operator to add it to the formula.
[RK2]

You must enter the various components in the correct syntax, for
example:
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•

enclose text in quotation marks: "This is a text string"

•

enclose function arguments in parentheses, where applicable:
ToNumber ({Orders. Order ID})
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•

reference formulas with a leading @ symbol: {@formula}

•

reference parameters with a leading ? symbol: {?parameter}

For more details about formula syntax, refer to the Edit Formula Field
dialog box section in the On-line Help file.
5. Edit the formula, if necessary. To make the formula more readable, press
ENTER to insert a line break.
6. Click the Check Formula button on the toolbar to check for errors, then
fix any syntax errors that are identified.
7. Click OK to close the dialog box, or Apply to save the formula without
closing the window.
8. The new formula field will appear in the Analysis Fields panel,
prefixed by @ symbol. To use the field in the query, drag it from the
Analysis Fields panel to the appropriate panel. The new field will
also appear in the Query Contents tab of the Analysis Explorer.

NOTE

There is no need to specify record or group selection conditions using a formula. To
restrict data, specify a condition in the Filters or Group Filters panel.

Adding SQL expression fields
SQL expressions are like formulas, except that they use SQL (Structured Query
Language) syntax, rather than the Seagate Analysis formula language. You can
use SQL expressions in much the same way as database fields. SQL expressions
are evaluated on the database server as long as the conditions for server-side
processing are satisfied. See Processing data on the database server in the Online Help for more details.
NOTE

You must have some familiarity with the SQL language and SQL expressions before
trying to add an SQL expression field to your query.

To add a SQL expression field:
1. Go to Insert | Formula.
2. In the New Name dialog box, type a name for the field in the Name box.
3. Make sure the ‘Perform on server’ option is checked on.
4. In the Edit SQL Expression Field dialog box, double-click or
drag a field or function to add it to the expression.
5. Edit the expression, if necessary. To make the expression more readable,
press ENTER to insert a line break.
6. Click the Check formula button on the toolbar to check the expression
for errors; then fix any syntax errors that are identified.
7. Click OK to close the dialog box, or Apply to save the formula without
closing.
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The new SQL expression field appears in the Analysis Fields panel,
prefixed by the @ symbol. To use the field in the query, drag it from the
Analysis Fields panel to the appropriate panel. The new field also appears
in the Query Contents tab of the Analysis Explorer.

Creating parameter fields
Parameters are fields that prompt the user to specify a value each time the data is
refreshed. When a value is supplied, the program runs the query using that value
in either the selection criteria or a formula. By using parameters, you can create
a single query that will return different data sets, depending on the your needs.
For example, if you have a database that contains information about the sales of
products across the United States, you could create a query that displays all the
customers in a particular state. By defining the state as a parameter, when you
refresh the data you can specify which state value Seagate Analysis will retrieve
from the data source. If you refresh the query again, you can add data for
another state to the result set.
There are two sorts of parameters: single-value prompts and multi-value
prompts. A multi-value prompt allows you to enter more than one value for the
parameter. In the previous example, if you enter the state as a multi-value
prompt, you can run the query for one or more states at a time.
To see an example of using a parameter, go to Favorites | Desktop
Admin, and open the File Extensions report.

To add a [RK3]parameter to the query:

1. From the Fields panel, right-click the field whose value you want to
specify as a parameter, and choose Create Prompting Parameter
Field on the shortcut menu.
2. Choose Create Single-value Prompt or, if you want the
parameter to accept multiple values, select Create Multi-value
Prompt.
3. The program creates a simple parameter, which it adds to the Analysis
Fields panel, and adds a simple condition based on the parameter to the
Filters panel. By default, Seagate Analysis will make the parameter
name the same as the selected database field, prefixed by the ? symbol.
4. When the query is refreshed, only those records that satisfy the condition in
the Filters panel will be returned. By default, the condition is set to
database field ‘is equal to’ parameter value. For example, state = ?state. If
you specified "New York" when prompted, Seagate Analysis would only
return the records where "New York" was the value for the state field.
To change the selection condition:

1. Right-click the condition in the Filters panel, and choose Edit from
the shortcut menu.
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2. In the Edit Field Range dialog box, choose a type of condition from
the list. The value is already set to the parameter.
3. Click OK.
To change the parameter properties:

1. Right-click the parameter in the Analysis Fields panel, and choose
Edit from the shortcut menu.
2. In the Parameter Field dialog box, change the name for the parameter in the
Field Name box, if necessary.
3. From the Field Type list, choose a data type.
4. If you want the parameter to accept multiple values, select the Multiple
Values check box.
5. Enter the text you want to be prompted by in the Prompting text box.
This is the message that appears when the program prompts the user for a
parameter value. The prompting text can have up to 255 alphanumeric
characters.
6. Type the default value in the Default Values box and press ENTER.
Alternatively, you can select a field from the list of fields and then choose a
default value from the list of values.
The default values are the values that you can choose from when you run
the query. If you want a choice of values, you must select them one at a
time from the list.
7. Click OK.
The new field appears in the Analysis Fields panel, prefixed by the ?
symbol.
When you create a parameter by the method above, it is automatically added to
the Filters panel.
You can also create a parameter by choosing the Insert | Parameter
command. To use the field in this case, drag it from the Analysis Fields
panel to the relevant panel. The new field also appears in the Query
Contents tab of the Analysis Explorer.
To enter the parameter value(s):

1. Refresh the query.
2. In the Parameter Field Prompts dialog box, choose a value for the selected
parameter.
3. You can type the value, or choose from the list of default values that you set
for the parameter. For a multi-value prompt, choose more than one value
from the list.
4. If the query contains more than one parameter, select the next parameter in
the list and specify a value for it, and so on.
5. When you have set the values for all the parameters in the query, click OK
to run the query.
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Changing table logon information
You can change the logon information (user name and password) for each table
involved in the query. Use this feature to prevent a logon dialog box appearing
when you refresh the data in the query.

To change the logon information for a table:
1. From the Data menu, choose Logon to Data Server.
2. In the Logon to Data Server dialog box, choose the table from the list on the
left.
3. Type a new user name in the User Name box.
4. Type a new password in the Password box.
5. If you want the new logon information to apply to all the tables, click
Apply to all tables.
6. To change the logon information for a second table, choose the table in the
list, and repeat steps 3 through 5.
7. Click OK.

NOTE

Before you using an ODBC data source in Seagate Analysis, make sure to configure the
ODBC DSN in the Windows Control panel. For more information about configuring ODBC
DSNs, see the Seagate Analysis Online Help files.

The Report tab
Viewing a report
Once you have defined a query using the Query tab in Seagate Analysis, you
can view it as a report.

To view a query as a report
•

Click the Report tab, or go to View | Report.

If you haven't already run the query, Seagate Analysis queries the data source
when you click the Report tab.
If the query retrieves a large amount of data, you can cancel the request by
clicking the Stop button on the toolbar, or by pressing the ESC key.
The report displays the data fetched by the query in a default format. If you have
grouped the results in the query, this grouping is also shown in the report.
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The Group Tree is shown on the left of the report. By expanding and clicking
the entries in the Group Tree, you can move directly to the detailed information
for a particular group. This is known as drilling down. (See below.)
You can apply one of a standard set of styles to the report to obtain sophisticated
formatting quickly. (See Formatting a report… Setting a report style.)
When you initially view a report, the first page is displayed at a magnification of
100%. You can move to a different page in the report, or change the
magnification.

Changing pages
You can move between pages to view any part of the report you want. Use the
buttons on the toolbar to move to the first, last, next, or previous page.
To move to a specific page:

1. Choose Edit | Go To.
2. In the Go To Page dialog box, enter the page number you want to view.
3. Click Go To.

Drilling down on a group
If you have grouped the query results, this grouping is also shown in the report.
The Group Tree is shown on the left of the report. By clicking the entries in the
Group Tree, or clicking group headers or footers, you can move directly to the
detailed information for a particular group. This is known as ‘drilling down’.
Each time you drill down, Analysis queries the database for the necessary data.
If you drill down in the Group Tree, Seagate Analysis does not open a separate
view.
If you drill down in the report itself, the details are shown in a drill-down view.
To show detailed information in a separate view, double-click a group header or
footer. The separate view enables you to switch between different parts of the
report.
To close the drill-down view, choose View | Close Drill-Down, or click
the Close Drill-Down button on the toolbar.
Using the Preview command also closes any drill-down views.

Zooming in and out
To zoom in or out, select a value from the drop-down list on the toolbar. You
can choose any magnification between 25% and 400%, or make the report fit the
page.
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Formatting a report
Report Sections
You can format the report to improve its legibility and to obtain the look you
want.
Reports are divided into a number of horizontal bands, called sections. A basic
report has five sections:
Report Header

This section is used for the report title and other information you want to
appear only once, at the beginning of the report. It can also be used for charts
that include data for the entire report.
This section is used for information that you want to appear at the top of each
page. This can include the name of the document. It can also display the field
titles above the fields in a report.
This section is used for the body of the report, and is printed once per record.
The bulk of the report data generally appears in this section.
This section usually contains the page number and any other information you
want to appear at the bottom of each page.
This section is used for information you want to appear only once in a report,
such as grand totals. It can also be used for charts that include data for the
entire report.

Page Header

Details
Page Footer
Report Footer

If the data in the query is grouped or includes a summary field, there are two extra sections:

Group Header

This section usually contains the group name field, and can be used to display
charts that include data specific to the group. It is printed once for every value
in the grouping field, at the beginning of the group.
This section usually contains the group name field and summary, and can be
used to display charts that include data specific to the group. It is printed once
for every value in the grouping field, at the end of the group.
The details for the group appear between the Group Header and the Group
Footer.

Group Footer

When you format a section, such as a group header, this changes the formatting
for all the group headers in the report. Similarly, formatting the details section
changes the formatting for all the details of the report.

Setting a report style
You can get a slick appearance for the report very quickly by applying one of
the standard report styles to the report.
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•

To set a standard style, go to Format | Report Styles and choose the
style you want from the submenu. Analysis applies that report style to the
report.

•

To remove a style, go to Format | Report Styles and then click
None.
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Changing row and column spacing
You can alter the row and column spacing in the report simply by dragging the
mouse.
To change the row spacing throughout a section:

1. Click within the section to select one of the entries.
2. A gray border with sizing handles appears.
3. Drag the bottom handle of the border to change the row spacing.
To change the width of a column throughout the report:

1. Click within the column to select one of the entries.
2. A gray border with sizing handles appears.
3. Drag the right or left handles on the border to set the new column width.

Formatting columns
You can specify the format of columns in the report and their headers.
1. To format a column or header, right-click the column or header, and choose
Format Field from the shortcut menu.
2. You can change general, border, and font properties by clicking the
corresponding tab:
General tab

To choose the alignment for the text in the field, use the Horizontal
Alignment list.
To size the field according to the value in the field, select Tight
Horizontal.
To give the field a drop shadow, select drop shadow.

Border tab

To choose the style of each part of the border, use the lists on the Border tab.
Set the color of the field using the Color area.
Use the Border list to set the border color.
Use the Background list to set the background color. To select a custom
color, click one of the buttons next to the Border or Background lists to
call the Color Chooser. For more details, see Color Chooser dialog
box in the On-line Help file.
[SS4]

Font tab

To change the font, choose from the Font Name list.
To change the font size, choose from the list to the right of Font Name.
To change the font color, choose from the Font Color list or click the
button to call the Color Chooser.
Select Bold, Italic, or Underlined as required.
3. Once done, click OK
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Formatting sections
You can specify the format of each section of the report. When you format a
section, you can:

NOTE

•

choose the background color for the section,

•

insert a new page before or after the section,

•

keep the section together (for page breaks),

•

suppress the section if it is blank

•

have the section underlay the following sections

•

reset the page number after the section, and

•

print the section at the bottom of the page.
Not all options are available for all section types.

To format a section:

1. Right-click within a section and choose Format Section from the
shortcut menu.
2. In the Section Expert dialog box, choose a section to format in the
Sections list.
3. In the Attributes area, select the formatting options you want.
4. Click OK.

Adding text to a report
You can use text to add extra titles or annotations to a report.
To add text to a report:

1. From the Insert menu, choose Text Object.
2. In the Insert Text Object dialog box, type the text you want to add in the
Text box.
3. Click OK. An object frame appears.
4. Click where you want to position the text.
To edit the text:

1. Right-click on the text and select Edit Text Object from the shortcut
menu.
2. In the Insert Text Object dialog box, make the changes to the text.
3. Click OK.
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Adding special fields to a report
You can add text with special properties to a report, such as dates and page
numbers. These fields are called special fields.
To add a special field:

1. From the Insert menu, choose Special Field.
2. In the Insert Special Field dialog box, choose the type of field
you want to add:
Page Number
TotalPageCount
Page N of M
Report Title
PrintDate
PrintTime
Record Selection
Formula
Group Selection
Formula
Data Date
Data Time
Modification Date
Modification Time
Record Number
Group Number

adds a page number
adds the total number of pages in the report.
adds the page number and total number of pages
adds a title to the report
adds the date when the report was printed
adds the time when the report was printed.
adds a record selection formula field
adds a group selection formula field.
adds the date when the data was last retrieved or refreshed
adds the time when the data was last retrieved or refreshed.
adds the date when the report was last modified
adds the time when the report was last modified
adds a number for each record in the details section
adds a number for each group
3. Click Insert. An object frame appears.
4. Click where you want to insert the field on the report.

Showing and hiding sections
By default, all sections of a report are visible.
To specify which sections should be visible in the report:

1. Right-click anywhere in the report and choose Show All Sections or Hide
Section from the shortcut menu.
2. To hide a report section, right-click the section and choose Hide
Section from the shortcut menu.
3. To show all the report sections, right-click anywhere in the report and
choose Show All Sections from the shortcut menu.
4. If you have previously hidden any of the report sections, these sections are
now displayed.
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Showing report data in a chart
Seagate Analysis allows you to insert charts into reports. You can use charts to
organize and present your data more efficiently, and to identify trends.
Creating and modifying the chart is easy with the use of the Chart Expert.
The Expert walks you through the creation of a chart step-by-step.
For information about adding charts to the Worksheet, refer to Showing
worksheet data in a chart in the On-line Help.
Within a report in Analysis, you can chart on:

•

a summary field, such as a sum or average, or

•

a detail field.

Charting on a summary field
Many useful charts you create are based on summary fields within the report.
For example, if you have a report showing sales summed by region, you can add
a chart to illustrate the percentage of sales in each region. In order to create a
summary chart, you must already have the summary field in the query.
To chart on a summary field:

1. Choose Insert | Chart, or click the Chart button on the toolbar.
2. In the Chart Type tab of the Chart Expert, choose a chart type from the
list. Click one of the buttons on the right to select the specific style you
want for that type of chart.
For example, you can choose ‘Bar Chart’ as the chart type, and ‘Stacked
Bar’ as the specific style.
For a description of chart types, see Chart Type Tab in the On-line Help
file.
3. Click the Data Field tab, and click the Group button to specify that the
chart will be based on grouped data.
4. Specify where the chart is placed, using the Place graph list and the
Header and Footer options. The placement of a chart determines which
data is displayed and where it is shown. For example, if you place a chart in
the Report Header section, the chart includes data for the entire report. If
you place it in a Group header or Group footer section, it displays group
specific data.
NOTE

When you summarize a field, the data is automatically grouped.

5. Choose a value from the On change of list to specify when a point is to
be plotted. This determines the x-axis values for 2-dimensional charts.
6. Choose a value from the Show Value(s) list to specify what data you
want to chart. This determines the y-axis values for 2-dimensional charts.
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7. If you wish, you can use the Chart Text tab to add titles to the axes, the
Options tab to specify the chart color and legend and the Axes tab to
control gridlines and tick marks.
8. Click OK.

Charting on a detail field
You can also chart on the values that appear in the details section of the report.
To chart on a detail field, you need to specify two things:
•

The condition, which indicates when to plot the point.
For example, a chart showing last year's sales for your customers uses the
Customer Name field as the condition. Each time the condition - the
customer name - changes, a point is plotted.

There can be up to two conditions when charting on a detail field.
•

The value, which indicates what information is to be plotted on the chart.
For example, to create a chart showing last year's sales for your customers,
use the Last Year's Sales field as the value.

You can specify multiple values.

To chart on a detail field:

1. Choose Insert | Chart, or click the Chart button on the toolbar.
2. In the Chart Type tab of the Chart Expert, choose a chart type from the
list. Click one of the buttons on the right to select the specific style you
want for your chart type.
For example, you can choose ‘Bar Chart’ as the chart type, and ‘Stacked
Bar’ as the specific style.
For a description of chart types, see ‘Chart Type Tab’ in the On-line Help
file.
3. Click the Data Field tab, and click the Detail button to specify a
detail chart.
4. Use the Place Chart list and the Header and Footer options to
specify chart placement. The placement of a chart determines which data is
displayed and where it is printed. For example, if you place a chart in the
Report header section, the chart includes data for the entire report. If you
place it in a Group header or Group footer section, it displays group specific
data.
5. Select fields from the Available Fields tree view which specify
when you want a point to be plotted and click the arrow (>) button to add
them to the On change of list.
6. Select fields from the Available Fields tree view which specify the
values you want to plot, then click the arrow (>) button to move them to the
Show Values list.
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7. If you want to summarize the values you have chosen, select a summary
operation from the Data summary type list.
8. If you want, you can use the Chart Text tab to add titles to the axes, the
Options tab to specify the chart color and legend and the Axes tab to
control gridlines and tick marks.
9. Click OK.

Positioning a chart
If the chart is not in the correct position, you can move or resize it. You do this
in the same way as positioning other report objects. See ‘Changing row and
column spacing’.

Formatting a chart
You can change an existing chart to alter any aspect of its formatting.
If you edit a chart in a group header or footer, editing one instance of the chart
will change the format of all occurrences of the chart.
The outline steps for editing a chart in the report are:
1. Right-click the chart and choose Format Chart from the shortcut menu.
2. Make your changes in the Chart Expert (see below for how to do
specific changes).
3. Click OK.

Changing the chart type
A wide range of chart types is available, so that you can pick the chart which
best displays your data.
1. Select the Chart Type tab of the Chart Expert, and choose a chart type
from the list. On the right, a set of buttons shows the available styles within
the selected type.
2. Click one of the buttons on the right to select a particular style of chart. A
short description of the type is shown in the Chart Description area.
For a description of chart types and how they might be used, refer to the Chart
type tab section under the Chart Expert dialog box in the On-line Help.

Changing the chart axes
The chart axes are automatically scaled and given gridlines and tick marks. You
can control these settings using the Axes tab of the Chart Expert.
Changing the range of axes

You can use the Axes Tickers area in the Axes tab of the Chart Expert to
control the highest and lowest values shown and the format of labels.
To change the range of an axis:
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1. In the Axes Tickers area, unselect Auto Range.
2. Enter new values in the Maximum and Minimum boxes.
3. If you want to change the format of the axis labels, choose an option from
the Number format list.
Changing the divisions of axes

You can use the Axes Divisions area in the Axes tab of the Chart Expert to
control the number of divisions in an axis
1. In the Axes tab of the Chart Expert, click Manual.
2. In the box to the right, type the number of divisions you want.

Displaying data values on the chart
You can control whether the data values are shown on the chart and the format
in which they appear.
1. In the Chart Type tab of the Chart Expert, select one of the options in
the Data Points area.
•

None does show a data value.

•

Show Label shows a label.

•

Show Value shows the value of the point.

2. If you selected Show Value, select a format for the numbers using the
Number format list. You can use this formatting to add a dollar sign in
front of the numbers, or a percent sign after them.

Changing the chart legend
You can control whether a legend appears, and where it is positioned.
1. In the Options tab of the Chart Expert, select Show Legend to display
a chart legend.
2. Choose a position for the legend from the Placement list.

Changing the text on the chart
You can change the text that appears in the chart, such as the chart title or axis
titles.
1. In the Chart Text tab of the Chart Expert, enter the text you want to
appear in each box beside each item in the Titles Text area.
2. Format the text by choosing an item from the list and clicking the Style
button.
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Pulling out pie slices
You can give a pie chart more impact by separating one of the slices from the
rest.
1. In the Chart Type tab of the Chart Expert, select Detach Slice in
the Chart Options area.
2. Select which slice you want to detach, by selecting Largest slice or
Smallest slice.

Saving a report
The Save command saves the whole Analysis document. If you have created an
Analysis document, or edited an existing one, the following information is saved
to a .rpt file:
•

the query,

•

the report,

•

the Worksheet view, and

•

the cube definition.

The saved Worksheet view includes everything displayed in the Worksheet.
When you next open the document, the Worksheet looks the same as when you
saved it, right down to the cell formatting, the sorting and the chart.

To save the document:
•

Click the Save button on the toolbar, or choose Save from the File
menu.

•

If you want to save the current data in the report, check the Save with
Data option on the File menu before saving. Otherwise, the report
may show different data when you next open it.

•

To save the document to a different file, use the Save As command.

Exporting a report
To gain further benefit from the information in the report, you can export it to
other commonly used formats. The formats you can use are:
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Microsoft Word (.doc)

•

Microsoft Excel (.xls)

•

Rich Text (.rtf)

Copyright  2001 Crystal Decisions, Inc. All Rights Reserved.

Page 39

Introduction to Seagate Analysis

The Report and Query Tabs in Seagate Analysis

To export a report to a file:

1. Choose File| Export, or click the Export button on the toolbar.
2. In the Export dialog box, choose an export format from the Export
Format list.
3. Enter the file name in the Save To box, or click Browse to select a file
path.
4. Click OK.

Printing a report
To print a report:

1. Choose File | Print, or click the Print button on the toolbar.
2. In the Windows Print dialog box, specify the print options you want.
3. Click OK.

Finding More Information
The following reference materials were used during the creation of this
Technical Support document, or are recommended for further reading on
subjects covered by the Topics of this Module Section.
Seagate Analysis On-line Help
Seagate Crystal Reports User’s Guide (Version 7)

Contacting Crystal Decisions for Technical Support
We recommend that you refer to the product documentation and that you visit
our Technical Support web site for more resources.
Self-serve Support:

http://support.crystaldecisions.com/
Email Support:

http://support.crystaldecisions.com/support/answers.asp
Telephone Support:

http://www.crystaldecisions.com/contact/support.asp
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